
Škoda Kamiq Extra už

od 19 280 €

Cenové zvýhodnenie

až 3 000 €

Bohatá základná výbava

Extra

Cenník Škoda Kamiq Extra



Zvýhodnenie* -3 000 -3 000
Akciová cena ** 19 280 20 790

Zvýhodnenie* -3 000 -3 000
Akciová cena ** 20 710 22 220

Zvýhodnenie* -3 000 -3 000
Akciová cena ** 22 810 24 320

Zvýhodnenie* -3 000 -3 000
Akciová cena ** 22 240 23 750

Zvýhodnenie* -3 000 -3 000
Akciová cena ** 24 340 25 850

Všetky informácie o aute
Modelová stránka

Vyskladajte si auto podľa seba
Online konfigurátor

* Akčný model Škoda Kamiq Extra nie je možné kombinovať s veľkoodberateľskými podmienkami. Bližšie informácie získate u participujúcich
autorizovaných partnerov značky Škoda.
** Najnižšie ceny príslušných motorových vozidiel za posledných 30 dní vám poskytujeme v zmysle zákona č. 108/2024 Z.z. o ochrane spotrebiteľa
a sú dostupné na internetovej stránke www.skoda.sk/ceny.

Kamiq Extra
Motor

.
Palivo

.
Prevodovka

.
Pohon

.
Cena (s DPH)

.
Extra

.
Extra Plus

.

1.0 TSI 70kW (95k)
.

Benzín
.

5° MP
.

predný
. Základná cena . 22 280 . 23 790 .

1.0 TSI 85kW (116k)
.

Benzín
.

6° MP
.

predný
. Základná cena . 23 710 . 25 220 .

1.0 TSI 85kW (116k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . 25 810 . 27 320 .

1.5 TSI 110kW (150k)
.

Benzín
.

6° MP
.

predný
. Základná cena . 25 240 . 26 750 .

1.5 TSI 110kW (150k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . 27 340 . 28 850 .
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Prečo práve Kamiq Extra?

Komfort a štýl
Akčný model Extra ponúka množstvo praktických doplnkov –
tempomat, automatickú klimatizáciu, výškovo nastaviteľné predné
sedadlá s vyhrievaním a lakťovú opierku s JumboBoxom. Pasažieri na
zadných sedadlách určite ocenia viac súkromia vďaka Sunsetu.

Chcete ešte viac? Pridajte si Plus
Akčný model Extra Plus si extra užijete vďaka obľúbeným výbavovým
prvkom pre naozaj náročných zákazníkov – vyhrievaným volantom,
bezkľúčovému ovládaniu KESSY, voľbou jazdného režimu Drive
Mode Select či nabíjaciemu Phoneboxu.

Teraz ešte výhodnejšie
Akčné modely Extra sú pre vás teraz k dispozícii ešte výhodnejšie – s
cenovým zvýhodnením až 3000 €. S rozpočtom vám navyše pomôže
značkové financovanie od Porsche Finance Slovakia s poistením
priamo v splátke.

Bezstarostne a bezpečne
Starosti s parkovaním hoďte pokojne za hlavu a parkujte ešte
jednoduchšie. Základná výbava akčného modelu prináša parkovacie
senzory (predné pre Extra Plus) a navyše aj parkovaciu kameru. V
čase neprítomnosti vaše auto postráži vstavaný alarm (pre Extra
Plus).

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Interiér Loft

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

ESC vrátane ABS, EBV, MSR, ASR, EDS, HBA, DSR, ESBS, XDS+,
TPM, multikolíznej brzdy (MKB) a funkcie Prefill

Front Assist - výstraha pred kolíziou a podpora núdzového brzdenia
a Pedestrian Monitor (ochrana chodcov)

Easy Light Assist – svetelný senzor

Lane Assist – asistent udržiavania v jazdnom pruhu

Driver Alert - asistent rozpoznania únavy a pozornosti vodiča

ISOFIX na sedadle spolujazdca

3. hlavová opierka vzadu

Easy Start – bezkľúčové štartovanie

Full LED predné svetlomety

Predné hmlové svetlá

Sivý strop

Disky Nyota z ľahkej zliatiny 6J × 16" – strieborné

Brzdy kotúčové (predné aj zadné)

Virtuálny kokpit 8"

Čítanie dopravných značiek

2-ramenný multifunkčný kožený volant

Tempomat

Infotainment Škoda s 8" displejom

8 reproduktorov

eCall, CareConnect na 3 roky

Bluetooth

Bezdrôtový Smartlink

2x USB-C vpredu + 2× USB vzadu (typ C len na nabíjanie)

Climatronic – dvojzónová automatická klimatizácia so senzorom
vlhkosti a kombi filtrom

Výškovo nastaviteľné sedadlo vodiča a spolujazdca

Vyhrievanie predných sedadiel

Lakťová opierka s JumboBox

Zadné parkovacie senzory

Zadná parkovacia kamera

Ukazovateľ stavu kvapaliny v ostrekovači

Sunset

Elektricky ovládané a vyhrievané vonkajšie spätné zrkadlá

Vonkajšie spätné zrkadlá a kľučky dverí lakované vo farbe karosérie

Elektrické ovládanie okien vzadu

Strešný nosič - čierny

Asistent rozjazdu do kopca

Paket Simply Clever: háčiky na tašky – pevné, nesklopné, odkladacia
schránka – na strane za podbehom, uchytávacie klipy pre sieťový
program, sieťový program, 12V zásuvka v batožinovom priestore

Dáždnik

Rezerva na oceľovom disku (neplnohodnotná), zdvihák, kľúč na kolesá

Predĺžená záruka na 5 rokov/100 000 km (platí tá z podmienok, ktorá
nastane skôr, prvé 2 roky bez obmedzenia počtu kilometrov)

ŠKODA – Doživotná Garancia Mobility Premium - Poskytuje pomoc
servisným vozidlom na mieste poruchy (porucha na vozidle, chýbajúce
PHM, defekt pneumatiky, zabuchnuté/stratené kľúče, vybitá batéria,
zámena paliva), odtiahnutie vozidla, prípadne služby – náhradnú
dopravu, požičanie náhradného vozidla, ubytovanie pre posádku a i.

Dažďový senzor

KESSY - bezkľúčové odomykanie, zamykanie a štartovanie

Alarm

Full LED zadné svetlá s dynamickým ukazovateľom smeru

2-ramenný kožený vyhrievaný multifunkčný volant (pre AP aj
podvolantovým ovládaním DSG)

Phonebox bez LTE

Predné a zadné parkovacie senzory

Driving Mode Select

Elektricky sklopné, ovládané a vyhrievané vonkajšie spätné zrkadlá

USB-C vo vnútornom spätnom zrkadle

Základná výbava

Extra

Extra Plus (navyše oproti Extra)
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Doplnková výbava

Light & View › Dažďový senzor
› Full LED zadné svetlá s dynamickým ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky sklopné vonkajšie spätné zrkadlá

WIH 480 •

Light&View Plus › Naviac oproti Light&View
› Full LED Matrix predné svetlomety

WII 1317 837

Adaptive Cruise Control - adaptívny tempomat do 210 km/h PC5 490 490

Assisted Drive › Adaptive Cruise Control - adaptívny tempomat do 210km/h
› Adaptive Lane Assist

PIA 668 668

Assisted Drive Plus › Naviac oproti Assisted Drive
› Side Assist
› Dažďový senzor
› Full LED zadné svetlá s dynamickým ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné zrkadlá

s automatickým stmievaním na strane vodiča

PIB 1343 863

Safety › Crew Protect Assist – proaktívna ochrana cestujúcich
› Kolenný airbag vodiča
› Bočné airbagy vzadu

WIX 544 544

Deliaca sieťová stena 3CX 125 125

Medzipodlaha batožinového priestoru 3GD 181 181

Simply Clever Plus › Sieťový program
› Odkladací priestor pod prednými sedadlami
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Držiak na tablet a telefón

(nie je možné s PWA)

PIK 280 280

Simply Clever Plus (pre elektricky
ovládané sedadlo vodiča)

› Sieťový program
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Držiak na tablet a telefón

(možné len s PWA/WQ7)

PI2 − 242

Príprava na ťažné zariadenie 1D7 216 216

Ťažné zariadenie – sklopné 1M6 1138 1138

Adaptér pre ťažné zariadenie ND1 40 40

Ostrekovače svetlometov 8X1 156 156

Interiér Lodge › Sedadlá Lodge
› Ambientné osvetlenie červené /biele
› Sivý poťah prístrojovej dosky
› Medené orámovanie výchudov ventilácie
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu
› Vonkajšie sivé prahové lišty

(iba s interiérom HP/HQ)

WQ3 502 502

Extra Extra PlusBezpečnosť

Extra Extra PlusFunkčnosť

Extra Extra PlusVolanty / interiéry / sedadlá
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Interiér Dynamic Plus › Športové sedadlá
› Čierny strop
› 3-ramenný športový vyhrievaný kožený multifunkčný volant

(pre AP s ovládaním DSG prevodovky)
› Ambientné osvetlenie prepínateľné červené /biele
› Čierny poťah prístrojovej dosky
› Červené orámovanie výchudov ventilácie
› Ozdobné kryty pedálov z ušľachtilej ocele
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu
› Dekoračné prahové lišty s názvom Kamiq

(iba s interiérom AH)

WQ4 1075 998

Interiér Suite › Poťah sedadiel Suedia /koža /umelá koža
› Čierny poťah prístrojovej dosky
› Chrómové orámovanie výchudov ventilácie
› Zadná ľakťová opierka
› Elektricky nastaviteľné sedadlo vodiča
› Ambientné osvetlenie prepínateľné červené /biele
› Vkladané tkané koberce vpredu a vzadu
› Vonkajšie sivé prahové lišty
› Dekoračné prahové lišty s názvom Kamiq

(iba s interiérom JG/JI)

WQ7 1689 1689

Elektricky nastaviteľné sedadlo vodiča (možné len s WQ3/PEA, nie je možné s PIK) PWA 501 501

2-ramenný kožený vyhrievaný multifunkčný volant PLE 109 •

3-ramenný kožený vyhrievaný športový multifunkčný volant PLM 248 139

2-ramenný kožený vyhrievaný multifunkčný volant pre DSG PLG 109 •

3-ramenný kožený vyhrievaný športový multifunkčný volant pre DSG PLP 248 139

Disky z ľahkej zliatiny Cortadero Aero 6J x 16" - strieborné
(pneu 205/60 R16)

PJ5 0 0

Disky z ľahkej zliatiny Montado Aero 6J x 16" – čierne, leštené
(pneu 205/60 R16)

PJ7 144 144

Disky z ľahkej zliatiny Kajam 6,5J x 17" - strieborné, vrátane Aero krytov
(pneu 205/55 R17)

PJG 604 604

Disky z ľahkej zliatiny Stratos 6,5J x 17" - strieborné
(pneu 205/55 R17)

PJP 564 564

Disky z ľahkej zliatiny Propus Aero 6,5J x 17" – čierne, leštené
(pneu 205/55 R17)

PJR 708 708

Disky z ľahkej zliatiny Fornax 7J x 18" – strieborné
(pneu 215/45 R18) (nie je možné pre 1.0 TSI 70 kW)

PJN 1189 1189

Disky z ľahkej zliatiny Ursa Aero 7J x 18" – čierne, vrátane Aero krytov
(pneu 215/45 R18) (nie je možné pre 1.0 TSI 70 kW)

P20 1230 1230

Disky z ľahkej zliatiny Vega Aero 7J x 18" – čierne
(pneu 215/45 R18) (nie je možné pre 1.0 TSI 70 kW)

PJV 1333 1333

Winter Premium › Vyhrievané čelné sklo
(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)

WIE 167 −

Winter Premium & Technology Plus › Vyhrievané čelné sklo
› Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)

PMA 372 167

Vyhrievané zadné sedadlá (nie je možné s WIE a PMA) 4A4 193 193

Paket pre zlé cesty (dodatočná ochrana podvozka) 1SK 72 72

Extra Extra PlusVolanty / interiéry / sedadlá

Extra Extra PlusDisky / pneumatiky

Extra Extra PlusKomfort
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Drive so Safe › Čierne lakované spätné zrkadlá a predná maska
› Sunset
› Sport Chassis Control–podvozok s nastaviteľnou tuhosťou tlmičov

(možné len s PJ7/PJV/PJR)
(nie je možné s PYC)

PKW 1113 692

Chrome paket › Podokenná chromová lišta
› Strieborný strešný nosič

PIF 271 271

Open Sky › Panoramatická strecha
› Čierny strop
› Čierny strešný nosič
› Bez schránky na okuliare

(možné len s interiérom AH/HQ/HO/JI)

WIW 878 878

Predné parkovacie senzory 7X2 371 •

Convenience so safe › Kessy - bezkľúčové odomykanie, zamykanie a štartovanie
› Drive Mode Select
› Predné parkovacie senzory
› Alarm

WJM 715 •

Convenience Premium so safe › Naviac oproti Convenience so safe:
› Elektricky ovládané piate dvere s virtuálnym pedálom
› 10" Virtuálny kokpit
› Parkovací asistent

(PYC platí pre Extra Plus)

WJO/PYC 1567 950

Technology Plus › Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

WIS 203 •

Navi paket › 9.2" Škoda Navigation
› 10" Virtuálny kokpit
› Web Rádio
› Hlasové ovládanie
› Infotaiment Online na 3 roky

WIT 1285 1285

Sound paket › Sound System Škoda,
› Rezervné koleso (dojazdové)
› Zdvihák + klúč na kolesá

(možné len s WQ3/PEA/WQ7 a naviac v kombinácii s 10" Virtuálnym
kokpitom možné len s WIT)

PJC 539 539

Alarm PD3 278 •

Black paket › Čierno-lakované spätné zrkadlá
› Čierna predná maska chladiča

(iba s PJ7/PJR/PJV)

PMY 38 38

Modrá Energy UNI 0 0

Biela Candy SPE 450 450

Metalické farby MET 650 650

Červená Velvet, Oranžová Phoenix FLT 1054 1054

Color Concept (čierna strecha) 6FG 545 545

Predĺžená záruka na 5 rokov/100 000km EA4 0 0

Predĺžená záruka na 5 rokov/150 000km EA9 205 205

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Extra Extra PlusKomfort

Extra Extra PlusMultimédiá

Extra Extra PlusZabezpečenie vozidla

Extra Extra PlusOstatné
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Ponuka farieb a diskov

Červená Velvet, metalická Modrá Race, metalická Biela Moon, metalická

Čierna Magic, metalická Sivá Graphite, metalická Strieborná Smokey Diamond, metalická

Oranžová Phoenix, metalická Modrá Energy, uni Biela Candy, uni

Propus Aero 17"
čierne

Stratos 17"
strieborné

Kajam 17"
strieborné

s aero krytmi

Montado Aero 16"
čierne

Nyota 16"
strieborné

Cortadero Aero 16"
strieborné

Oceľové disky 16"
s krytmi Tecton

Ursa Aero 18"
strieborné

s aero krytmi

Fornax 18"
strieborné

Vega Aero 18"
čierne

s aero krytmi
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Servis 5 rokov / 75 000 km 818 1556

Servis 5 rokov / 100 000 km 1046 2178

Servis 5 rokov / 150 000 km 1526 3438

Basic ProfessionalServisné balíčky

Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH 23%.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 06.02.2026 (MR2027)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda
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